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�New in SmartHeap 8.0

Improved performance

The SmartHeap 8.0 multi-threaded libraries contain performance optimizations making them up to 2x faster than version 7.  The performance improvement is greatest on the Windows operating system.  

Note that the general performance improvements in SmartHeap version 8, and those described under MemDefaultPoolThreadExclusive, below, are available only when running on single-processor (including hyperthread-enabled Intel processor) systems.  The performance enhancements are enabled on SMP systems only in the SmartHeap/SMP product.

New API controls thread-specific heap usage

SmartHeap 8.0 introduces a new API, MemDefaultPoolThreadExclusive, that can be used to greatly enhance performance and simplify heap object deallocation in applications that use heap exclusively in one or more threads.  Applications that will benefit from this new API are those that have one or more heap-intensive threads which exclusively free the memory they allocate.

Use MemDefaultPoolThreadExclusive only in threads that exclusively free all heap pointers that are allocated by that thread after the call to MemDefaultPoolThreadExclusive.  

The new API has the following prototype:

MEM_BOOL MemDefaultPoolThreadExclusive(unsigned flags);

Specify one of the following values for flags: 

MEM_THREAD_EXCLUSIVE_OFF: default behavior – current thread uses process-wide default memory pool.  Heap operations are synchronized with other threads.

MEM_THREAD_EXCLUSIVE_ON: creates thread-specific default memory pool for the current thread.  Synchronization with other threads is not needed, resulting in improved performance.  ��Specify this value only if all allocations created with malloc, calloc, new, or realloc in the calling thread are freed exclusively by the same thread. Can be combined disjunctively with MEM_FREE_ON_THREAD_TERM.

MEM_FREE_ON_THREAD_TERM: creates thread-specific default memory pool for the current thread.  All allocations created in the current thread are automatically freed at thread termination, simplifying and improving performance of storage management.  Note that you still must calls delete for objects created with operator new in order for destructors to execute, though you can override operator delete for such objects with an empty operator delete definition if desired (if the objects are used exclusively in thread-specific memory pools) since SmartHeap will automatically free the memory at thread termination.��Specify this value only if all allocations created with malloc, calloc, new, or realloc in the calling thread are either not freed or are freed exclusively by the same thread, and if there are no references to allocations created in the calling thread from other threads after the calling thread terminates.  Can be combined disjunctively with MEM_THREAD_EXCLUSIVE_ON.

Call this API from each thread where you want one or both of the above behaviors.

Improved Debug SmartHeap compiler debug info support

SmartHeap Version 8 now uses dbghelp.dll for symbol and file/line information to support heap error diagnostics, which provides greater compatibility with more compiler and debugging information formats. 

Note: dbghelp.dll ships with several Microsoft Windows operating systems and with Visual Studio 2003 and later. If dbghelp.dll is not installed on your system, you can find a copy in the SmartHeap \bin directory.

New in SmartHeap 7

SmartHeap 7 further improves SmartHeap support for Visual Studio .NET.  Unmanaged C/C++ projects are supported with both static and dynamic linking. Debug SmartHeap can now query VC7 pdb data to obtain file and line numbers for its error reports. SmartHeap 7 also supports Intel’s hyperthreading technology.

SmartHeap 7 includes libraries to support 64-bit Windows running on Itanium hardware.

New in SmartHeap 6

Improved design

SmartHeap 6.0 offers better absolute speed and better memory utilization. Unlike SmartHeap 5, it returns memory to the OS, and the user can control both how much is returned and when it is returned.

A new API is introduced in SmartHeap 6.0 primarily for the benefit of UNIX valloc and memalign.  MemAllocAligned (MEM_POOL pool, unsigned long size, unsigned long alignment, unsigned flags) is identical to MemAllocPtr except that the result is aligned to a multiple of the value specified in the “alignment” parameter.

New tuning APIs

Several new tuning APIs are introduced in this release:

void MemProcessSetFreeBytes(unsigned long bytes) controls how much free space SmartHeap maintains in the large block heap. In SmartHeap 5 this was infinite (memory was never returned to the OS). In SmartHeap 6 the user can control exactly when SmartHeap returns memory to the OS via this API. The default value is 10MB, meaning that SmartHeap won’t start releasing memory to the OS until the large block heap has more than 10MB of free space. Larger values result in better allocation performance but larger process footprint.

void MemProcessSetLargeBlockThreshold (unsigned long bytes) controls the block size SmartHeap manages in its large block heap. The default size is 512KB. Blocks larger than the threshold value are allocated by the OS and freed directly to the OS. Larger values result in better performance but potentially larger process footprint.

unsigned long MemPoolSetFreeBytes(MEM_POOL pool, unsigned long bytes) controls free space in a pool just as MemProcessSetFreeBytes controls free space in the large block heap. The default value is 1MB. Large values result in better performance and less contention at the expense of more space for allocations less than 16K in size. When this value is non-zero, SmartHeap leaves empty pages, up to the aggregate size specified, inside the pool. When a pool needs to add a page it can do so without a global lock or a large-block heap allocation by recycling a page previously freed by the same pool.

Installing SmartHeap

The files on the SmartHeap installation disks are not compressed or copy protected.  

To install SmartHeap on your hard disk:

Copy the files in the include directory to a directory on your compiler’s include file path. 

Copy the files in the library directory corresponding to your compiler (msvc) to a directory on your linker’s library file path. 

Copy the files in the bin directory to the Windows NT, Windows 2000, or Windows XP system32 directory, or to the Windows 9x system directory, or some other directory on the PATH. 

(optional)  Copy the files from source and/or samples to examine or modify the SmartHeap source files and sample applications.

�Files in the Win32/Win64 SmartHeap release

This  version of SmartHeap includes:

Import libraries for Microsoft Visual C++.

Statically linkable libraries for Microsoft Visual C++.

Compiler-independent DLLs.

Platform-independent header files.

Platform-independent source files for the malloc and C++ operator new definitions.

The SmartHeap CD contains the following Windows–specific files:

Directory	File	Description

include	smrtheap.h	Header file containing all Runtime SmartHeap C �		declarations except malloc.

include	smrtheap.hpp	Header file containing Runtime SmartHeap C++ �		declarations, including operator new.

include	shmalloc.h	Header file containing declarations for Runtime �		SmartHeap ANSI C functions (malloc, etc.).

include	heapagnt.h	Header file containing all Debug SmartHeap �		declarations.

bin	shsmp.dll	32-bit runtime SmartHeap dynamic link library.

bin	shsmp.dbg	32-bit symbols for Runtime SmartHeap DLL.

bin	shsmpd.dll	32-bit debug SMP SmartHeap dynamic link library.

bin	shsmpd.dbg	32-bit symbols for Debug SMP SmartHeap dynamic 		link library

bin\vc7	shw32d.dll	32-bit debug SmartHeap dynamic link library for Visual 		C++ 7 and earlier.

bin\vc8	shw32d.dll	32-bit debug SmartHeap dynamic link library for Visual 		C++ 8.

bin	shsmp64.dll	64-bit runtime SmartHeap dynamic link library.

bin	shsmpd64.dll	64-bit debug SMP SmartHeap dynamic link library.

bin	shw64d.dll	64-bit debug SmartHeap dynamic link library.

bin	dbghelp.dll	Windows image helper used by debug SmartHeap.

msvc	shsmp.c	Source file for “quick start” procedure when using �		SmartHeap with a non-MFC application (32-bit builds 		only)..

msvc	shmfcsmp.cpp	Source file for “quick start” procedure when using �		SmartHeap with an MFC application. (32-bit builds 

		only).

�Directory	File	Description

msvc	shlsmpmt.lib	32-bit runtime SmartHeap multi-thread statically linkable �		library for Microsoft Visual C++.

msvc	shlsmpmtd.lib	32-bit runtime SmartHeap multi-thread statically linkable �		debug SMP library for Microsoft Visual C++.

msvc	shdsmpmt.lib	32-bit runtime SmartHeap multi-thread DLL import 

		library for Microsoft Visual C++.

msvc	shdsmpmtd.lib	32-bit runtime SmartHeap multi-thread DLL import 

		debug SMP library for Microsoft Visual C++.

msvc\64	shlsmp64mt.lib	64-bit runtime SmartHeap multi-thread statically linkable �		library for Microsoft Visual C++.

msvc\64	shlsmp64mtd.lib	64-bit runtime SmartHeap multi-thread statically 

		linkable debug SMP library for Microsoft Visual C++.

msvc\64	shdsmp64mt.lib		64-bit runtime SmartHeap multi-thread DLL 

		import library for Microsoft Visual C++.

msvc\64	shdsmp64mtd.lib	64-bit runtime SmartHeap multi-thread DLL 

		import debug SMP library for Microsoft Visual C++.

msvc\vc6	shmfc4m.lib	32-bit statically linkable multi-thread library file for 

		Microsoft VC++ 6/MFC 4.x/5.x — for statically linked 

		Release MFC only; must link before SmartHeap library.

msvc\vc7	shmfc4m.lib	32-bit statically linkable multi-thread library file for 

		Microsoft VC++ 7 — for statically linked 

		Release MFC only; must link before SmartHeap library.

msvc\vc8	shmfc4m.lib	32-bit statically linkable multi-thread library file for 

		Microsoft VC++ 8 — for statically linked 

		Release MFC only; must link before SmartHeap library.

msvc\vc6	shdw32md.lib	32-bit debug SmartHeap DLL import library for 

		Microsoft Visual C++ 6.

msvc\vc7	shdw32md.lib	32-bit debug SmartHeap DLL import library for 

		Microsoft Visual C++ 7.

msvc\vc8	shdw32md.lib	32-bit debug SmartHeap DLL import library for 

		Microsoft Visual C++ 8.

msvc\64	shdw64md.lib	64-bit debug SmartHeap DLL import library for 

		Microsoft  Visual C++.

�Directory	File	Description

msvc\vc6	shmfc32md.lib	32-bit statically linkable library file for Microsoft VC++ �		6/MFC 3.0 — for statically linked _DEBUG MFC only; �		must link before Debug SmartHeap library.

msvc\vc6	shmfc4md.lib	32-bit statically linkable library file for Microsoft Visual �		C++6/MFC 4.x/5.x — for statically linked _DEBUG MFC �		only; must link before Debug SmartHeap library. 

msvc\vc7	shmfc32md.lib	32-bit statically linkable library file for Microsoft VC++ �		7/MFC 3.0 — for statically linked _DEBUG MFC only; �		must link before Debug SmartHeap library.

msvc\vc7	shmfc4md.lib	32-bit statically linkable library file for Microsoft Visual �		C++7/MFC 4.x/5.x — for statically linked _DEBUG MFC �		only; must link before Debug SmartHeap library.

msvc\vc8	shmfc32md.lib	32-bit statically linkable library file for Microsoft VC++ �		8/MFC 3.0 — for statically linked _DEBUG MFC only; �		must link before Debug SmartHeap library.

msvc\vc8	shmfc4md.lib	32-bit statically linkable library file for Microsoft Visual �		C++8/MFC 4.x/5.x — for statically linked _DEBUG MFC �		only; must link before Debug SmartHeap library.

borland	shdsmpbt.lib	32-bit runtime SmartHeap multi-thread DLL import 

		library for Borland compilers (Intel only). 

borland	shlsmpbt.lib	32-bit runtime SmartHeap multi-thread static library for �		Borland compilers (Intel only).

borland	shsmp.lib	32-bit runtime SmartHeap multi-thread DLL import 

		library for Borland compilers (Intel only).

borland	shdw32bd.lib	32-bit debug SmartHeap static library for Borland 

		compilers (Intel only). 

borland	shw32d.lib	32-bit debug SmartHeap multi-thread DLL import library 

		for Borland compilers (Intel only).

source	shmalloc.c	SmartHeap definition for ANSI C (malloc, etc.) �		functions — provided so you can customize these. 

source	shmalmac.c	Macro versions of SmartHeap ANSI C (malloc, etc.) �		functions. 

source	shnew.cpp	SmartHeap definition for operator new — provided �		so you can customize and/or build a library for �		non-supported compilers. 

source	shnewi.cpp	SmartHeap definition of shi_New

source	shnewhnd.cpp	SmartHeap new handler definitions

source	def*.c,	Default memory pool definitions 

	db*.c	used by the above malloc and new definitions. 

samples		Various sample SmartHeap applications with Microsoft �		Visual C++ and Borland C++ make files. 

Before you begin

Beginning with Visual Studio .NET, Microsoft radically changed the VC++ development environment (the IDE).  This required us to write a new set of linking instructions for users of this new generation of Microsoft development tools. Because the changes are so extensive, we decided it would cause the least confusion to our users if we gave two separate sets of linking instructions: one for users of Visual C++ 6 and earlier compilers, and one for users of Visual Studio .NET and later: 

Instructions for using earlier versions of Microsoft compilers (through Visual C++ 6) begin immediately below. 

For instructions on using Visual Studio .NET, see “� REF _Ref39934140 \* MERGEFORMAT �Using SmartHeap/SMP with Visual Studio .NET�.”

If you are using the new SmartHeap 64-bits libs with 64-bit Windows an Itanium hardware, see Using SmartHeap/SMP with Win64.

Important! If you’re building a 32-bit application that will run on x86 hardware, you must link to the SmartHeap 32-bit libraries.  If you’re building a 64-bit app that will run on Itanium1 or Itanium2 hardware, you must link to the SmartHeap 64-bit libs.

Using SmartHeap with Microsoft Visual C++ Versions 4, 5, or 6 (Win32)

If you’re developing an application with Microsoft Visual C++ for 32-bit Windows, versions 4, 5 or 6, here’s how to get started with SmartHeap. 

Important: The following pages describe two different ways to accomplish the same end of linking your project to SmartHeap. We recommend the “Quick Start” procedure if you’re using a Microsoft Visual C++ compiler. 

If you get link errors when using Quick Start, or if for some reason you need more explicit control of your linking options, then use the alternative linking procedure described below under “Setting up your application for the SmartHeap runtime library” (for linking with the runtime library) and “Debugging an application with SmartHeap” (for debug builds). In this case we would also suggest that you force a reference to SmartHeap as described in the section “Resolving Visual C++ duplicate-definition linker errors.” Usually this last step is not necessary, but it doesn’t hurt.

If you’re using a Borland compiler please see  “Using SmartHeap with Borland Compilers.”

Quick start

If your goal is to quickly get SmartHeap into your project so that it simply replaces malloc and operator new in your application, follow the instructions in this section.  This procedure uses a source file with #pragma statements that force references to the correct set of SmartHeap libraries for your application based on your project’s compile-time flags.  This method is better than explicitly referencing SmartHeap libraries, because it ensures that the correct SmartHeap libraries are linked – both initially and whenever you subsequently change your project settings.

If you want to use SmartHeap APIs, or if you want explicit control of which SmartHeap libraries your application uses, see the detailed instructions in the sections “Setting up your application for the SmartHeap runtime library” and “Debugging an application with SmartHeap,” later in this booklet.

�Specifying the location of SmartHeap files

To tell Visual C++ where to find SmartHeap include and library files:

From the Visual C++ Tools menu, choose Options, and the Options dialog box appears.

Choose the Directories tab.  

Under Show Directories For, choose “Include files.”

Choose the Add button, and add the path of the SmartHeap include directory to the include path list, for example:  

		c:\smrtheap\include

Choose the Add button again, and add the path of the SmartHeap msvc directory to the include path list, for example: 

		c:\smrtheap\msvc

Under Show Directories For, choose “Library files.” 

Choose the Add button, and add the path of the SmartHeap vc6 directory to the library path list, for example:

		c:\smrtheap\msvc\vc6

Choose OK to save your changes.

Setting up a Visual C++ MFC project

To set up a Visual C++ MFC project to work with SmartHeap:

Open the file stdafx.cpp in your project. 

At the beginning of stdafx.cpp, before any #include statements, insert the following text:

		#include "shmfcsmp.cpp"

Save your changes to stdafx.cpp.

Choose Rebuild All from the Build menu (Visual C++ 4.x/5.x/6.x).

Repeat the Rebuild All command for both the Release and Debug project configurations.

Setting up a Visual C++ non-MFC project

To set up a Visual C++ project to work with SmartHeap if the project does not use MFC:

Open your application’s project file.

Add the file shsmp.c to your project.  This file is located in the SmartHeap msvc directory.  

Display the Project Settings dialog box.

Under Settings For, choose “Win32 Release,” if it isn’t chosen already. 

Choose the Link tab. 

At the beginning of “Object/library modules,” before any other object files or libraries, enter the following: 

		.\Release\shsmp.obj

Under Settings For, choose “Win32 Debug.”

Choose the Link tab.

At the beginning of “Object/library modules,” before any other object files or libraries, enter the following:

		.\Debug\shsmp.obj

10.	Choose OK to save changes to Project Settings.  

11.	Rebuild both Release and Debug versions of the project.

�Setting up your application for the SmartHeap runtime library (Win32)

Here’s the detailed procedure for setting up your application to use the SmartHeap runtime library.  For information on debugging your application with Debug SmartHeap, see “Debugging an application with SmartHeap,” later in this booklet.

Adding the SmartHeap header file to your source files

Important!  If you’re not calling SmartHeap APIs, skip to the next page.  You don’t need to add SmartHeap header files if you simply want SmartHeap to replace malloc and operator new.  

For each file that makes SmartHeap API calls:

For C source files, include smrtheap.h, which contains declarations for the C SmartHeap APIs.

	#include <smrtheap.h>

For C++ source files, include smrtheap.hpp, which contains declarations for SmartHeap versions of operator new and which itself includes smrtheap.h.

	#include <smrtheap.hpp>

In both cases, the #include directive must appear after any compiler or library header files that declare malloc (for example, stdlib.h) or new (for example, new.h or afx.h).

�Specifying the location of SmartHeap files

To tell Visual C++ where to find SmartHeap include and library files:

1.	Choose Options from the Visual C++ Tools menu, and the Options dialog box appears.

2.	Choose the Directories tab.  

3.	Under Show Directories For, choose “Include files.”

4.	Choose the Add button, and add the path of the SmartHeap include directory to the include path list, for example:  

c:\smrtheap\include

Again under Show Directories For, choose “Library files.”

Choose the Add button, and add the path of the SmartHeap msvc directory to the library path list, for example:  

c:\smartheap\msvc

7.	If you’re using the MFC integration libs (shmfc*.lib), choose the Add button, and add the path of the SmartHeap msvc\vc6 directory to the library path list, for example:  

c:\smrtheap\msvc\vc6

Choose OK to save your changes.

�Setting up the Visual C++ project file

Here’s how you set up a Visual C++ project file to work with SmartHeap.  

Note  You must repeat the following procedure for each EXE and DLL in your application.  

To set up a Visual C++ project to work with SmartHeap:

Choose Open Workspace from the Visual C++ File menu, and open your application’s project file.

Choose Settings from the Project menu (Visual C++ 2.x) or Build menu (Visual C++ 4.x/5.x/6.x), and the Project Settings dialog box appears.

Under Settings For, choose “Win32 Release,” if it isn’t chosen already.

Choose the Link tab.

Specify the SmartHeap libraries that you want to link with.  At the beginning of Object/Library Modules, before any Visual C++ libraries, enter the appropriate libraries:

	Link with these libraries �If you’re using the SmartHeap DLL with	(in the order shown)

An EXE or DLL in a multi-threaded app,�without MFC, with statically linked MFC 3.0, �or the MFC 3.0/4.x DLL	shdsmpmt.lib

An EXE or DLL with a multi-threaded app,�with statically-linked MFC 4.x	shmfc4m.lib, shdsmpmt.lib

	Link with these libraries �If you’re statically linking SmartHeap with	(in the order shown)

An EXE or DLL in a multi-threaded app,�without MFC, or with statically-linked MFC 3.0	shlsmpmt.lib

An EXE or DLL in a multi-threaded app,�with statically-linked MFC 4.x	shmfc4m.lib, shlsmpmt.lib

�Note  shdsmpmt.lib and shlsmpmt.lib appear in the msvc sub-directory under the directory where you installed SmartHeap.  shmfc4m.lib appears in the msvc\vc6 directory.

MFC users!  If your application uses the DLL version of MFC, you must use the DLL version of SmartHeap (shdsmpmt.lib).  If your application links with Debug MFC, you must link with Debug SmartHeap.

Choose OK to save changes to Project Settings.  

Choose Build filename from the Build menu, and Visual C++ relinks the application. 

�Debugging an application with SmartHeap (Win32)

Here’s the detailed procedure for setting up your application for debugging with Debug SmartHeap.  

Adding the Debug SmartHeap header file to your source files

If you want to call Debug SmartHeap APIs (dbgMemXXX), you’ll need to include the Debug SmartHeap header file and recompile your application.  

Note  Simply linking with the Debug SmartHeap Library is sufficient to allow SmartHeap to perform full error detection.  Moreover, if your application is compiled with Visual C++ PDB debugging information, Debug SmartHeap obtains file names and line numbers directly from the debugging information.  So if you aren’t calling Debug SmartHeap APIs, there is no need to recompile your application for Debug SmartHeap.

For non-Intel platforms, Debug SmartHeap is not able to obtain file and line information from Visual C++ PDB debug information. If you want Debug SmartHeap to include file names and line numbers in error reports, you must include heapagnt.h in your source files and define the preprocessor constants MEM_DEBUG and DEFINE_NEW_MACRO.

For each file from which you call Debug SmartHeap APIs: 

Include heapagnt.h, which contains declarations of memory-allocation functions both for ANSI C (malloc, free, and so on) and for C++ (including the new and delete operators).  The #include directive must appear after any compiler or library header files that declare malloc (for example, stdlib.h) or new (for example, new.h or afx.h):

	#include <heapagnt.h>

�Note  If you already include smrtheap.h, shmalloc.h, or smrtheap.hpp, then you don’t need to also include heapagnt.h.  The Runtime SmartHeap header files automatically include heapagnt.h when MEM_DEBUG is defined.

Specifying the location of Debug SmartHeap files

To tell Visual C++ where to find Debug SmartHeap include and library files:

1.	Choose Options from the Visual C++ Tools menu, and the Options dialog box appears.

2.	Choose the Directories tab.  

3.	Under Show Directories For, choose “Include files.”

4.	Choose the Add button, and add the path of the Debug SmartHeap include directory to the include path list, for example:  

		c:\smrtheap\include

5.	Again under Show Directories For, choose “Library files.”

6.	Choose the Add button, and add the path of the Debug SmartHeap msvc\vc6 directory to the library path list, for example:  

		c:\smrtheap\msvc\vc6

Choose OK to save your changes

�Setting up the Visual C++ project file

Here’s how you set up a Visual C++ project file so you can debug the corresponding EXE or DLL with Debug SmartHeap.  

Note  You must repeat the following procedure for each EXE and DLL in your application.  

To set up a Visual C++ project to work with Debug SmartHeap:

1.	Choose Open Workspace from the Visual C++ File menu, and open your application’s project file.

2.	Choose Settings from the Project menu (Visual C++ 2.x) or Build menu (Visual C++ 4.x/5.x/6.x), and the Project Settings dialog box appears.

3.	Under Settings For, choose “Win32 Debug,” if it isn’t chosen already.

4.	Choose the C/C++ tab and, under Debug Info, choose “Program Database.”

5.	If you’re using Intel SmartHeap, and if your application doesn’t call Debug SmartHeap APIs, you can skip this step.

Still at the C/C++ tab, in Preprocessor Definitions, add: 

		MEM_DEBUG=1

6.	Choose the Link tab.

7.	Check the Generate Debug Info checkbox.

�8.	Still at the link tab, based on the following table, specify the Debug SmartHeap libraries that you want to link with.  At the beginning of Object/Library Modules, before the Visual C++ libraries, enter the appropriate libraries:

	Link with these libraries �If you’re debugging	(in the order shown)

An EXE or DLL without MFC, with non-Debug MFC,�or with the Debug MFC DLL	shdw32md.lib

An EXE or DLL with Debug MFC 3.0 statically linked	shmfc32md.lib, �	shdw32md.lib

An EXE or DLL with Debug MFC 4.x statically linked	shmfc4md.lib, �	shdw32md.lib

Note  The files shdw32md.lib, shmfc32md.lib, and shmfc4md.lib appear in the msvc\vc6 sub-directory under the directory where you installed SmartHeap.  

10.	Choose OK to save changes to Project Settings.  

�Recompiling or relinking your application

If you’re calling Debug SmartHeap APIs, or if you’re using the Alpha version of SmartHeap, you need to include the Debug SmartHeap header file and recompile your application.  Information on including this header file appears at the beginning of the section. 

Note  You only need to recompile your application if you’ve included the Debug SmartHeap header file in one or more of your source files.  However, you must always relink each EXE and DLL in your application for Debug SmartHeap.

To recompile your application:

1.	From the File menu, choose Open Workspace, and open your application’s project file, if you haven’t already done so. 

2.	Choose Rebuild All from the Project menu (Visual C++ 2.x) or from the Build menu (Visual C++ 4.x/5.x/6.x), and Visual C++ compiles the application.

To relink your application:

1.	From the File menu, choose Open Workspace, and open your application’s project file, if you haven’t already done so. 

2.	Choose Build filename from the Project menu (Visual C++ 2.x) or from the Build menu (Visual C++ 4.x/5.x/6.x), and Visual C++ relinks the application.

Using SmartHeap/SMP with Visual Studio .NET (Win32)

If you’re developing an application with Visual Studio .NET, Visual Studio 2003 or Visual Studio 2005 for 32-bit Windows, here’s how to get started with SmartHeap. 

Important: The following pages describe two different ways to accomplish the same end of linking your project to SmartHeap. We recommend the “Quick Start” procedure if you’re using any Microsoft Visual C++ compiler

If you get link errors when using Quick Start, or for some reason you need more explicit control of your linking options, then use the alternative linking procedure described below under “Setting up your application for the SmartHeap runtime library” (for linking with the runtime library) and “Debugging an application with SmartHeap” (for debug builds). In this case we would also suggest that you force a reference to SmartHeap as described in the section “Resolving Visual C++ duplicate-definition linker errors.” Frequently this last step is not necessary, but it doesn’t hurt. 

Quick start

If your goal is to quickly get SmartHeap into your project so that it simply replaces malloc and operator new in your application, follow the instructions in this section.  This procedure uses a source file with #pragma statements that force references to the correct set of SmartHeap libraries for your application based on your project’s compile-time flags.  This method is better than explicitly referencing SmartHeap libraries, because it ensures that the correct SmartHeap libraries are linked – both initially and whenever you subsequently change your project settings. 

If you want to use SmartHeap APIs, or if you want explicit control of which SmartHeap libraries your application uses, see the detailed instructions in the sections “Setting up your application for the SmartHeap runtime library” and “Debugging an application with SmartHeap,” later in this booklet. 

Specifying the location of SmartHeap files

To tell Visual Studio .NET where to find SmartHeap include and library files: 

Open the project’s Property Pages dialog box and click the C/C++ folder. 

Click the General property page. 

Modify the Additional Include Directories property by adding the path of the SmartHeap include directory.

Still in the project’s Property Pages dialog box, click the Linker folder. The General property page should be selected. 

Modify the Additional Library Directories property by adding the path of the SmartHeap msvc directory. If your project uses MFC you may also want to add the msvc\vc7 directory. This is where the SmartHeap MFC integration libs are located. You will also want to add the msvc\vc7 directory for debug builds.

Choose OK to save your changes. 

Setting up a Visual C++ MFC project

To set up a Visual C++ MFC project to work with SmartHeap: 

Open the file stdafx.h in your project.

At the beginning of stdafx.h, before any #include statements, insert the following text:

		#include " shmfcsmp.cpp "

Save your changes to stdafx.h.

Choose Rebuild <project name> from the Build menu.

Repeat the Rebuild command for both the Release and Debug project configurations.

�Setting up a Visual C++ non-MFC project

To set up a Visual C++ project to work with SmartHeap if the project does not use MFC:

1.	Open your application’s project file.

2.	Add the file shsmp.c to your project.  This file is located in the SmartHeap msvc directory.  

3.	Open the project’s Property Pages dialog box 

4.	In the Configuration drop-down list box, choose “Release,” if it isn’t chosen already. 

5.	Click the Linker folder and select the Input property page.

6.	At the beginning of the “Additional Dependencies” line, before any other object files or libraries, enter the following: 

		.\Release\shsmp.obj

7.	In the Configuration drop-down list box, choose “Debug,” if it isn’t chosen already. 

8.	Again click the Linker folder and select the Input property page.

9.	At the beginning of “Additional Dependencies” line, before any other object files or libraries, enter the following: 

		.\Debug\ shsmp.obj

10.	Choose OK to save changes.  

11.	Rebuild both Release and Debug versions of the project.

�Setting up your application for the SmartHeap runtime library (Win32)

Here’s the detailed procedure for setting up your application to use the SmartHeap runtime library.  For information on debugging your application with Debug SmartHeap, see “Debugging an application with SmartHeap,” later in this booklet.

Adding the SmartHeap header file to your source files

Important!  If you’re not calling SmartHeap APIs, skip to the next page.  You don’t need to add SmartHeap header files if you simply want SmartHeap to replace malloc and operator new.  

For each file that makes SmartHeap API calls:

For C source files, include smrtheap.h, which contains declarations for the C SmartHeap APIs.

	#include <smrtheap.h>

For C++ source files, include smrtheap.hpp, which contains declarations for SmartHeap versions of operator new and which itself includes smrtheap.h.

	#include <smrtheap.hpp>

In both cases, the #include directive must appear after any compiler or library header files that declare malloc (for example, stdlib.h) or new (for example, new.h or afx.h).

Specifying the location of SmartHeap files

To tell Visual Studio .NET where to find SmartHeap include and library files: 

1.	Open the project’s Property Pages dialog box and click the C/C++ folder. 

2.	Click the General property page. 

3.	Modify the Additional Include Directories property by adding the path of the SmartHeap include directory

4.	Still in the project’s Property Pages dialog box, click the Linker folder. The General property page should be selected.

5.	Modify the Additional library Directories property by adding the path of the SmartHeap msvc directory. If your project uses MFC, you may also need to add the msvc\vc7 directory (see below).

6.	Choose OK to save your changes. 

Setting up the Visual C++ project file

Here’s how you set up a Visual C++ project file to work with SmartHeap.  

Note  You must repeat the following procedure for each EXE and DLL in your application.  

To set up a Visual C++ project to work with SmartHeap:

Choose Open from the Visual C++ File menu, and open your application’s project file.  (In some circumstances you may prefer to use the Open Solution option from the File menu.)

Open the project’s Property Pages dialog box.

In the Configuration drop-down list box, choose “Release,” if it isn’t chosen already. 

Click the Linker folder and select the Input property page.

�Specify the SmartHeap libraries that you want to link with.  At the beginning of “Additional Dependencies” line, before any other object files or libraries, enter the appropriate libraries:

	Link with these libraries �If you’re using the SmartHeap DLL with	(in the order shown)

An EXE or DLL in a multi-threaded app,�without MFC, with statically linked MFC 3.0, �or the MFC 3.0/4.x DLL	shdsmpmt.lib

An EXE or DLL with a multi-threaded app,�with statically-linked MFC 4.x	shmfc4m.lib, shdsmpmt.lib

	Link with these libraries �If you’re statically linking SmartHeap with	(in the order shown)

An EXE or DLL in a multi-threaded app,�without MFC, or with statically-linked MFC 3.0	shlsmpmt.lib

An EXE or DLL in a multi-threaded app,�with statically-linked MFC 4.x	shmfc4m.lib, shlsmpmt.lib

Note  Most of the above library files appear in the msvc sub-directory under the directory where you installed SmartHeap. The MFC integration library shmfc4m.lib appears in the vc7 subdirectory under \msvc.  

MFC users!  If your application uses the DLL version of MFC, you must use the DLL version of SmartHeap (shdsmpmt.lib).  If your application links with Debug MFC, you must link with Debug SmartHeap.

Still on the Input property page, on the “Force symbol references” line, put _SmartHeap_malloc and _SmartHeap_new.  If your app uses MFC also put _SmartHeap_mfc.  (This step is optional.)   

Choose OK to save your changes.

8.	Choose Rebuild <project name> from the Build menu, and Visual C++ relinks the application.

�Debugging an application with SmartHeap (Win32)

Here’s the detailed procedure for setting up your application for debugging with Debug SmartHeap.  

Adding the Debug SmartHeap header file to your source files

If you want to call Debug SmartHeap APIs (dbgMemXXX), you’ll need to include the Debug SmartHeap header file and recompile your application.  

Note  Simply linking with the Debug SmartHeap Library is sufficient to allow SmartHeap to perform full error detection.  Moreover, if your application is compiled with Visual C++ PDB debugging information, Debug SmartHeap obtains file names and line numbers directly from the debugging information.  So if you aren’t calling Debug SmartHeap APIs, there is no need to recompile your application for Debug SmartHeap.

For each file from which you call Debug SmartHeap APIs: 

Include heapagnt.h, which contains declarations of memory-allocation functions both for ANSI C (malloc, free, and so on) and for C++ (including the new and delete operators).  The #include directive must appear after any compiler or library header files that declare malloc (for example, stdlib.h) or new (for example, new.h or afx.h):

	#include <heapagnt.h>

Note  If you already include smrtheap.h, shmalloc.h, or smrtheap.hpp, then you don’t need to also include heapagnt.h.  The Runtime SmartHeap header files automatically include heapagnt.h when MEM_DEBUG is defined.

�Specifying the location of Debug SmartHeap files

To tell Visual Studio .NET where to find SmartHeap include and library files: 

Open the project’s Property Pages dialog box and click the C/C++ folder. 

Click the General property page. 

Modify the Additional Include Directories property by adding the path of the SmartHeap include directory

Still in the project’s Property Pages dialog box, click the Linker folder. The General property page should be selected. 

Modify the Additional library Directories property by adding the path of the SmartHeap msvc\vc7 directory.

Choose OK to save your changes. 

Setting up the Visual C++ project file

Here’s how you set up a Visual C++ project file so you can debug the corresponding EXE or DLL with Debug SmartHeap.  

Note  You must repeat the following procedure for each EXE and DLL in your application.  

To set up a Visual C++ project to work with Debug SmartHeap:

1.	Choose Open from the Visual C++ File menu, and open your application’s project file. (In some circumstances you may prefer to use the Open Solution… option from the File menu.)

2.	Open the project’s Property Pages dialog box.

3.	In the Configuration drop-down list box, choose “Debug,” if it isn’t chosen already. 

4.	Click the C/C++ folder and select the General property page.

5.	Under “Debug  Information Format” choose Program database for edit & continue.

6.	If your application doesn’t call Debug SmartHeap APIs, you can skip this step.

Still at the C/C++ folder, in the Preprocessor property page on the Preprocessor Definitions line, add: 

		MEM_DEBUG=1

7.	Click the Linker folder and select the Debug property page.

8. 	Set Generate Debug Info to “Yes.”

9.	Still in the linker folder, select the Input property page. 

10.	Specify the SmartHeap libraries that you want to link with.  At the beginning of “Additional Dependencies” line, before any other object files or libraries, enter the appropriate libraries:

	Link with these libraries �If you’re debugging	(in the order shown)

An EXE or DLL without MFC, with non-Debug MFC,�or with the Debug MFC DLL	shdw32md.lib

An EXE or DLL with Debug MFC 3.0 statically linked	shmfc32md.lib, �	shdw32md.lib

An EXE or DLL with Debug MFC 4.x statically linked	shmfc4md.lib, �	shdw32md.lib

Note  The debug libs will be found in the vc7 subdirectory under \msvc 

Still on the Input property page, on the “Force symbol references” line, put _SmartHeap_malloc and _SmartHeap_new.  If your app uses, MFC also put _SmartHeap_mfc.  (This step is optional.).  

Choose OK to save changes to the property pages.

�Using SmartHeap/SMP with Win64

Linking Instructions � Runtime Builds

To link with the Smartheap static lib, just put shlsmp64mt.lib on your linker command line before any other libraries.

To link with the Smartheap DLL, just put shdsmp64mt.lib on your linker command line before any other libraries.

SMP/Debug versions of the runtime libs are also available: shlsmp64mtd.lib for static linking, and shdsmp64mtd.lib for dynamic linking. See “Using SmartHeap debug SMP libraries” elsewhere in this guide for additional information.

Linking Instructions � Debug Builds

To link with the Smartheap debug lib, just put shdw64mtd.lib on your linker command line before any other libraries. Debug SmartHeap always uses the SmartHeap debug DLL, so copy this DLL to a directory where your process can find it.

SmartHeap/Microsoft Visual C++ compatibility issues

Resolving Visual C++ duplicate-definition linker errors

If your application does not reference the functions malloc and free, you may receive duplicate-definition linker errors when you try to link the SmartHeap library into your application.  To eliminate these linker errors, use the following procedure:

1.	From the File menu, choose Open Workspace, and open your application’s project file, if you haven’t already done so. 

2.	Choose Settings from the Project menu (Visual C++ 2.x) or from the Build menu (Visual C++ 4.x/5.x/6.x), and the Project Settings dialog box appears.

3.	Choose the Link tab, and select the Input category.

4.	In Force Symbol References, add the symbol _SmartHeap_malloc.

Alternatively, if you’re using the command-line linker, add the following linker option:

-include:_SmartHeap_malloc

Using SmartHeap with Visual C++ Debug C runtime libraries

Visual C++ 4.0 and higher includes debugging versions of the C runtime libraries.  Debug SmartHeap supports these libraries, but Runtime SmartHeap does not.  Therefore, if your application links with the Debug C runtime library, it must also link with the Debug SmartHeap library (shdw32md.lib) rather than the Runtime SmartHeap library (shlsmpmt[d].lib, shdsmpmt[d].lib, ).

Debug SmartHeap overrides the Visual C++ functions _calloc_dbg, _realloc_dbg, _free_dbg, _msize_dbg, _expand_dbg, _CrtCheckMemory, _CrtDumpMemoryLeaks, _CrtIsValidHeapPointer, _CrtIsMemoryBlock, _CrtSetAllocHook, and _CrtSetBreakAlloc.  Debug SmartHeap emulates the behavior of each of these Visual C++ routines, so you can use these routines interchangeably with Debug SmartHeap APIs.

�Using SmartHeap with MFC 3.0/4.x

Debug SmartHeap defines replacements for all of the public memory-debugging APIs of the Microsoft Foundation Class Library.  This allows Debug SmartHeap to be used with _DEBUG MFC.  Runtime SmartHeap is not compatible with Debug MFC.  Debug SmartHeap emulates all MFC APIs except for AfxDoForAllObjects and the CMemoryState member functions.  For the unsupported APIs, SmartHeap defines stubs that print error messages that point to the corresponding SmartHeap APIs offering similar functionality.

If your application uses the statically linked Debug version of MFC, you must link with the SmartHeap/MFC integration library:  shmfc32md.lib for MFC 3, or shmfc4md.lib for MFC 4.x.  Be sure to place this library before either the SmartHeap or MFC libraries on the linker command line.  If your application uses the statically linked Release version of MFC 4.x, you must link with shmfc4m.lib.  Note that no integration is required for the Release (non-debug) version of MFC 3.0, since this library doesn’t override new/delete.

The DLL version of MFC 3.0 and higher requires applications to share the same memory manager that the MFC DLL itself uses.  (This is a change from MFC 2.x, where the MFC DLL called back to the client application for memory management.)  To allow SmartHeap applications to work with the DLL version of MFC, the SmartHeap DLLs automatically patch the memory-management functions in the MFC and CRT DLLs.  

Important  The statically linked SmartHeap library (shlsmpmt.lib) does not patch MFC or CRT DLLs, so if your application uses the MFC or CRT DLLs, you must use the DLL version of SmartHeap (shdsmpmt.lib or shdw32md.lib).

�Compiler functions that SmartHeap overrides

SmartHeap overrides malloc, calloc, realloc, free, new, and delete on all platforms, as explained in §2.3.2, §2.3.3, and §2.3.4 of the SmartHeap Programmer’s Guide.  In addition, the Microsoft Visual C++ SmartHeap libraries override the following functions:

Function	SmartHeap library module

_expand	shmalloc

_heapchk	shmalloc

_heapmin	shmalloc

_heapset	shmalloc

_heapwalk	shmalloc

_msize	shmalloc

If you don’t want SmartHeap to override these C runtime functions, you should remove the applicable object module from the SmartHeap library that you link with.  For example, use the following command to prevent SmartHeap from overriding malloc with the statically linked Microsoft Runtime SmartHeap library:

lib shlsmpmt.lib /remove:shmalloc.obj

If you remove the shmalloc object module from a SmartHeap library, you will need to define SmartHeap_malloc at file scope.  For example:

int SmartHeap_malloc = 0;

�Using SmartHeap with Borland Compilers (32-bit only)

If you’re developing an application with Borland C++ version 4.x or 5.x or Borland C++ Builder version 4, 5, or 6 for 32-bit Windows, here’s how to get started with SmartHeap.  

Getting started with the Runtime SmartHeap library

Here’s how you set up your application to use the Runtime SmartHeap library.  For information on debugging your application with Debug SmartHeap, see “Debugging an application with SmartHeap,” later in this booklet.

Adding the SmartHeap header file to your source files

Important!  If you’re not calling SmartHeap APIs, skip to the next section.  You don’t need to add SmartHeap header files if you simply want SmartHeap to replace malloc and operator new.  

For each file that makes SmartHeap API calls:

For C source files, include smrtheap.h, which contains declarations for the C SmartHeap APIs.

	#include <smrtheap.h>

For C++ source files, include smrtheap.hpp, which contains declarations for SmartHeap versions of operator new and which itself includes smrtheap.h.

	#include <smrtheap.hpp>

In both cases, the #include directive must appear after any compiler or library header files that declare malloc (for example, stdlib.h) or new (for example, new.h or afx.h).

Setting up the Borland C++ project file

Here’s how you set up a Borland C++ project file to work with Runtime SmartHeap.

Note  You must repeat the following procedure for each EXE and DLL in your application.  

To set up a Borland C++ project to work with Runtime SmartHeap:

1.	Choose Open Project from the Borland C++ Project menu, and open your .ide file.

2.	Choose Project from the Options menu, and the Project Options dialog box appears.

3.	From the Topics list, choose Directories (if it isn’t already chosen), and the directories options appear.

4.	In the Include list, add the path of the SmartHeap include directory, for example:  

c:\smrtheap\include

5.	In the Library list, add the path of the SmartHeap borland directory, for example:  

c:\smrtheap\borland

6.	Choose OK to save your changes.

�7.	Add the Runtime SmartHeap Libraries that are pertinent to your application.  To add each library, select your project’s EXE or DLL in the Project window, press the Insert key, and specify the file in the Add to Project List dialog box:

If you’re statically linking  SmartHeap, link with shlsmpbt.lib.

If you’re using the SmartHeap DLL, link with shdsmpbt.lib and shsmp.lib (in that order).

These files appears in the borland sub-directory under the directory where you installed SmartHeap.  

OWL users!  If your application uses the DLL version of OWL, you must use the DLL version of SmartHeap (shdsmpbt.lib).

Choose Make All from the Project menu, and Borland C++ links the application.

Setting up the Borland C++ Builder project file

Here’s how you set up a Borland C++ Builder project file to work with Runtime SmartHeap.

Note  You must repeat the following procedure for each EXE and DLL in your application.  

To set up a Borland C++ Builder project to work with Runtime SmartHeap:

1.	Choose Open Project from the Borland C++ Builder File menu, and open your .bpr file.

2.	Choose Options from the Project menu, and the Project Options dialog box appears.

3.	Choose Directories/Conditionals tab (if it isn’t already chosen), and the directories options appear.

4.	In the Include list, add the path of the SmartHeap include directory, for example:  

	c:\smrtheap\include

5.	In the Library list, add the path of the SmartHeap borland directory, for example:  

	c:\smrtheap\borland

6.	Choose OK to save your changes.

7.	Add the Runtime SmartHeap Libraries that are pertinent to your application.  To add each library, open the Project Manager from the Borland C++ Builder View menu and select your project’s EXE or DLL in the Project window. Press the Insert key, and specify the file in the Add to Project List dialog box:

If you’re statically linking  SmartHeap, link with shlsmpbt.lib.

If you’re using the SmartHeap DLL, link with shdsmpbt.lib and shsmp.lib (in that order).

These files appear in the borland sub-directory under the directory where you installed SmartHeap.  

OWL users!  If your application uses the DLL version of OWL, you must use the DLL version of SmartHeap (shdsmpbt.lib).

8.	Choose Make All from the Project menu, and Borland Builder links the application.

�Debugging an application with SmartHeap

Here’s how you set up your application for debugging with Debug SmartHeap.  

Adding the Debug SmartHeap header file to your source files

If you want Debug SmartHeap to include source file and line information in its error reports, or if you want to call Debug SmartHeap APIs (dbgMemXXX), you need to include the Debug SmartHeap header file and recompile your application.  

Note  Simply linking with the Debug SmartHeap Library is sufficient to allow SmartHeap to perform full error detection, but in most cases you’ll also want to recompile your application so that SmartHeap includes source file names and line numbers in its error reports.

For each file for which you want SmartHeap to report source file and line information: 

Include heapagnt.h, which contains declarations of memory-allocation functions both for ANSI C (malloc, free, and so on) and for C++ (including the new and delete operators).  The #include directive must appear after any compiler or library header files that declare malloc (for example, stdlib.h) or new (for example, new.h or afx.h):

	#include <heapagnt.h>

Note  If you already include smrtheap.h, shmalloc.h, or smrtheap.hpp, then you don’t need to also include heapagnt.h.  The Runtime SmartHeap header files automatically include heapagnt.h when MEM_DEBUG is defined.

�Setting up the Borland C++ project file

Here’s how you set up a Borland C++ project file to work with Debug SmartHeap.

Note  You must repeat the following procedure for each EXE and DLL in your application.  

To set up a Borland C++ project to work with Debug SmartHeap:

Choose Open Project from the Borland C++ Project menu, and open your .ide file.

Choose Project from the Options menu, and the Project Options dialog box appears.

From the Topics list, choose Directories (if it isn’t already chosen), and the directories options appear.

In the Include list, add the path of the SmartHeap include directory, for example:  

c:\smrtheap\include

In the Library list, add the path of the SmartHeap borland directory, for example:  

c:\smrtheap\borland

Now double-click Compiler in the Topics list, and the list expands to show the compiler options.

Choose Defines from the list, and enter this value in Defines:

MEM_DEBUG=1�DEFINE_NEW_MACRO=1

Choose OK to save your changes.

Add the Debug SmartHeap libraries, shdw32bd.lib and shw32d.lib (in that order) to your project.  Select your project’s EXE or DLL in the Project window, press the Insert key, and specify the file in the Add to Project List dialog box:

This file appears in the borland sub-directory under the directory where you installed SmartHeap.  

Setting up the Borland C++ Builder project file

Here’s how you set up a Borland C++ Builder project file to work with Debug SmartHeap.

Note  You must repeat the following procedure for each EXE and DLL in your application.  

To set up a Borland C++ Builder project to work with Debug SmartHeap:

1.	Choose Open Project from the Borland C++ Builder File menu, and open your .bpr file.

2.	Choose Options from the Project menu, and the Project Options dialog box appears.

3.	Choose Directories/Conditionals tab (if it isn’t already chosen), and the directories options appear.

4.	In the Include list, add the path of the SmartHeap include directory, for example:  

	c:\smrtheap\include

5.	In the Library list, add the path of the SmartHeap borland directory, for example:  

	c:\smrtheap\borland

In the Conditionals list add these defines:  

MEM_DEBUG=1

DEFINE_NEW_MACRO=1

Choose OK to save your changes.

Add the SmartHeap debug libraries shdw32bd.lib and shw32d.lib (in that order), to your project..  To add each library, open the Project Manager from the Borland C++ Builder View menu and select your project’s EXE or DLL in the Project window. Press the Insert key, and specify the file in the Add to Project List dialog box:

These files appear in the borland sub-directory under the directory where you installed SmartHeap.  

9.	Choose Make All from the Project menu, and Borland Builder links the application.

Recompiling your application

If you want SmartHeap to include source file and line number information in its error reports, you need to include the Debug SmartHeap header file and recompile your application.  Information on including this header file appears at the beginning of the section. 

Note  You only need to recompile your application if you’ve included the Debug SmartHeap header file in one or more of your source files.  However, you must always relink each EXE and DLL in your application for SmartHeap.

To recompile your application using Borland C++:

Choose Open Project from the Project menu, and open the .ide file, if you haven’t already done so. 

Choose Build All from the Project menu, and Borland C++ compiles the application.

To recompile your application using Borland C++ Builder:

Choose Open Project from the File menu, and open the .bpr file, if you haven’t already done so. 

Choose Build All Projects from the Project menu, and Borland Builder compiles the application.

Or, to relink your application using Borland C++:

1.	Choose Open Project from the Project menu, and open the .ide file, if you haven’t already done so. 

Choose Make All from the Project menu, and Borland C++ links the application.

To relink your application using Borland C++ Builder:

Choose Open Project from the File menu, and open the .bpr file, if you haven’t already done so. 

Choose Make All Projects from the Project menu, and Borland Builder links the application.

SmartHeap/Borland C++ compatibility issues

Using SmartHeap with OWL

The DLL version of the Borland Object Windows Library (OWL) requires applications to share the same memory manager that the OWL DLL itself uses. To allow SmartHeap applications to work with the DLL version of OWL, the SmartHeap DLLs automatically patch the memory-management functions in the OWL and CRT DLLs.  

�SmartHeap Win32 platform notes

Multi-threading in Windows

SmartHeap for SMP is fully thread-reentrant and thread-enabled, meaning that multiple threads calling malloc/free/new/delete can concurrently proceed with no blocking.

Note  It is not necessary to call MemRegisterTask or define MemDefaultPoolFlags in SmartHeap 4.0 and higher as in previous SmartHeap versions and on some other platforms.   However, if you create your own SmartHeap memory pools, you must still specify MEM_POOL_SERIALIZE in the flags parameter if the pool is referenced in more than one thread.

Using SmartHeap debug SMP libraries

The SmartHeap debug SMP  libraries are useful for detecting heap errors which may only manifest on an smp machine when multiple threads are performing heap operations concurrently. These bugs may not be apparent under other heap managers (CRT and debug SmartHeap for example) that serialize heap access.

Use the smp debug libraries with runtime (not debug) CRT. Do not use them for general purpose debugging: use the SmartHeap debug libraries instead.

Two debug SMP libraries are provided: shdsmp[64]mtd.lib and shlsmp[64]mtd.lib. The former uses the SmartHeap smp debug DLL shsmp[64]d.dll; the latter is a static library.

If you use the debug SMP libraries, ensure that you have not disabled SmartHeap error reporting (it is enabled by default). If an error is detected, you will get an error report. Note that overwrites will only be detected by a call to MemPoolCheck:

Note  The “Quick Start” linking procedure described above will not work with the debug SMP libraries. Instead, use the linking procedure that allows you to specify the lib your application should use. Refer to the topic “Setting up your application for the SmartHeap runtime library,” but use shdsmp[64]mtd.lib instead of shdsmp[64]mt.lib, or shlsmp[64]mtd.lib instead of shlsmp[64]mt.lib

Using shared memory in SmartHeap for Win32

Beginning in version 3.1, SmartHeap supports Windows 95 and Windows NT shared memory.  SmartHeap uses memory mapped files to implement shared memory pools.  All of the SmartHeap allocation APIs that accept a memory pool parameter, including MemAllocPtr, MemAllocFS, MemAlloc, and operator new with the placement syntax, support Win32 shared memory.

To create shared memory pools in Win95 or NT, use MemPoolInitNamedShared or MemPoolInitNamedSharedEx.  You must specify both the name and size parameters as non-zero.  

The name parameter is passed through to CreateFileMapping.  It can contain any characters but backslash (\).  

The size parameter is used to reserve address space for the memory pool.  The memory pool cannot grow larger than this size, but SmartHeap will commit memory to the shared pool based on allocation requests.  Therefore, you should specify a size that is the maximum (high water mark) memory requirement for the pool.  SmartHeap will commit only as much physical memory as you allocate from the pool regardless of the size parameter you specify.  Nevertheless, you should not specify an excessively large size parameter, or you will waste address space.  This is particularly important in Win95, where shared memory address space is common to all processes.  To help in choosing a suitable size value, you can use MemPoolSize to determine the total memory actually consumed by a memory pool at any time.

Once you’ve created a shared memory pool, you can call MemPoolAttachShared from other processes, specifying the same name you previously supplied to MemPoolInitNamedShared[Ex].  If you don’t know which of your processes will create and which will attach to a shared pool, you can call MemPoolInitNamedShared[Ex] from each process, specifying the same name in each call.  If a shared pool of the given name already exists, MemPoolInitNamedShared[Ex] will attach to and return that pool.  In this case, the other parameters to MemPoolInitNamedShared[Ex] are ignored.

Mapping shared memory pools to the same address in each process

Because SmartHeap allocation APIs return direct pointers to memory, SmartHeap requires shared memory pools to be mapped to the same address in each process.  In Windows 95, this is not a problem since shared memory is always mapped to the same address in each process.  NT, however, does not guarantee that shared memory is mapped to the same address in each process.  If you create a shared pool in one process and call MemPoolAttachShared in another process in which the address of the memory pool is unavailable, MemPoolAttachShared will fail (it will return NULL after reporting a MEM_OUT_OF_MEMORY error).

To solve this problem, SmartHeap 3.1 includes a new API, MemPoolInitNamedSharedEx.  This API lets you specify the address at which a shared memory pool should be mapped (addr) and/or an array of process IDs that will access the shared pool (pids).  If you specify a non-NULL value for pids, SmartHeap will search the address space of each of these processes to find a suitable address that is available in all of the processes.

MemPoolInitNamedSharedEx also lets you specify security Win32 attributes for the shared pool.  The security parameter you specify is passed through to CreateFileMapping.

In choosing the addr parameter, you should examine the DLLs in each process that will use the shared pool, and find an address space location that is available in each process.  You should use MemPoolAttachShared as early as possible during process initialization to ensure that the address range you selected is not used by a call to VirtualAlloc.

If you specify addr as NULL, SmartHeap chooses a random address in the upper half of the application address space for NT, or a random address in the shared memory address space for Win95.  This minimizes the chance of collisions with other shared pools or VirtualAlloc objects (which are normally allocated from the beginning of the address space).

If all of the processes that will share a memory pool are running at the time that you create the memory pool, you can have SmartHeap find an address automatically by specifying pidCount and pids parameters.  In this case, the shared pool will be mapped into each process’s address space before the MemPoolInitNamedSharedEx call returns.  If there is no address space region of suitable size available in every process, MemPoolInitNamedSharedEx will fail (this would be very unusual considering that each process has 2 GB of address space).

If you’ve specified a pids array to MemPoolInitNamedSharedEx, and if you’re running on NT, and if you’re using the SmartHeap DLL, then when you call MemPoolAttachShared from one of the processes that you previously specified to MemPoolInitNamedSharedEx, you may specify the return value of MemPoolInitNamedSharedEx as the pool parameter along with a NULL name parameter.  This is the only case where the name parameter of MemPoolAttachShared is optional in the Win32 SmartHeap implementation.  You may also specify both name and pool parameters as non-NULL, or just the name parameter as non-NULL if you wish.  For Win95 compatibility, the name parameter must always be specified as non-NULL.

Caution  The address-space searching feature of MemPoolInitNamedSharedEx is implemented fully only in the DLL version of SmartHeap (both Debug and Runtime).  In the DLL version (shdsmpmt.lib), MemPoolInitNamedSharedEx will cause the new pool to be mapped into each specified process before the call returns, which guarantees that the pool can be shared between the given processes.  In the statically linked version of SmartHeap (shlsmpmt.lib), MemPoolInitNamedSharedEx searches each specified process and reserves space at a suitable address region, but does not actually map the pool into the other processes during the call to MemPoolInitNamedSharedEx.  If the chosen address region becomes unavailable in a given process before MemPoolAttachShared is called in that process, then MemPoolAttachShared will fail.  Therefore, to guarantee that a set of processes will be able to successfully share a memory pool in NT, you must use the DLL version of SmartHeap (shdsmpmt.lib).

Miscellaneous details

Shared memory pools are always serialized with inter-process synchronization mutual exclusion.  You can concurrently allocate blocks from a shared pool from multiple processes with complete safety.

You can use all of the SmartHeap allocation and de-allocation APIs with shared memory pools.  In Debug SmartHeap, shared memory pools fully support all of the same debugging facilities as private memory pools.

If SmartHeap detects an error such an overwrite in a shared pool, the error is reported to the process in which the error is detected, regardless of where the shared memory pool was created.  Debug SmartHeap error reports in Win32 include the ID of both the thread and the process where the error was  detected, as well as the thread/process IDs where the erroneous object was created.

In Debug SmartHeap, when you compile your source files with MEM_DEBUG, SmartHeap stores a pointer to the source file name in each allocated memory block.  The actual file name is a string constant, generated by the compiler, that exists only in the private address space of the process.  For shared memory pools, SmartHeap copies file name strings into space owned by the shared memory pool, so the file names are accessible from all processes that attach to the pool.  Only the first 19 characters of file names are stored, so if you allocate shared memory from source files having longer names, the file names reported in memory error reports will be truncated to the first 19 characters.

To end access to a shared pool from a given process, call MemPoolFree from that process.  The shared pool will continue to exist until every process that has access to it calls MemPoolFree.  The process that creates a shared pool does not need to be the last process to call MemPoolFree; shared pools are not owned by a particular process.

See also §2.4.5, “Shared memory,” and the entries for MemPoolInitRegion, MemPoolInitNamedShared, MemPoolInitNamedSharedEx, and MemPoolAttachShared in §4.2, “Function reference,” in the SmartHeap Programmer’s Guide.

�SmartHeap’s automatic DLL patching

Note  You can skip this section if you statically link SmartHeap.  Only the SmartHeap DLL does any patching of DLLs.

When you link with the DLL version of SmartHeap, SmartHeap automatically patches heap routines in compiler DLLs, such as the C runtime and MFC DLLs.  If you’re using MFC, OWL, or other DLLs that share heap memory with their client EXE, this patching is required to ensure that objects allocated in these DLLs can be safely freed by your application’s EXE.

Note  SmartHeap “patching” does not affect the on-disk copy of any DLLs, and it does not affect other applications that use the DLLs that SmartHeap patches.  SmartHeap modifies only the in-memory copy of the DLL that is private to your application’s process.  Runtime SmartHeap patches only those DLLs in your process that export heap APIs such as malloc or new.  Debug SmartHeap also patches all DLLs that have PDB debug information and that contain statically linked heap API definitions.

In some cases, you may want to disable SmartHeap’s patching of compiler DLLs.  You can selectively or globally disable SmartHeap’s patching by adding values to the registry, as described in the following section.

�Controlling patching via the registry

You can disable patching either for all of the DLLs in your application or for selected DLLs by adding keys to the Windows NT or Windows 95 registry, as described in the following procedures.  You can add registry keys in either of two ways:

Use the Registry Editor (regedt32.exe on NT, regedit.exe on Win95) to add these registry entries manually. 

Use the Win32 registry API to add registry keys and values programmatically.  This is the method you should use if your application uses the Runtime SmartHeap DLL and you don’t want SmartHeap to patch one or more of the DLLs used by your application.

Important!  If you’re using MFC, OWL, or other DLLs that share heap memory with their client EXE, do not disable patching for those DLLs, or you may encounter incompatibilities and unexpected GPFs.

Note  SmartHeap stores its settings under the HKEY_LOCAL_MACHINE registry key for compatibility with NT services.  Previous SmartHeap releases (version 3.01 and earlier) stored these settings in HKEY_CURRENT_USER.

To disable SmartHeap patching for all DLLs:

1.	Add the following key to the Windows NT or Windows 95 registry:

For Runtime SmartHeap, add the registry key:

HKEY_LOCAL_MACHINE\Software\MicroQuill\�SmartHeap\Apps\<app-name>

For Debug SmartHeap, add the registry key:

HKEY_LOCAL_MACHINE\Software\MicroQuill\�HeapAgent\Apps\<app-name>

where <app-name> is the full path of your application’s EXE.

Important!  Use forward slashes (/) as directory delimiters.  Backslash characters (\) are not legal in registry keys.  

For example, if your application’s full path is c:\apps\foo.exe and you want to disable patching for Runtime SmartHeap, you’d add the registry key:

HKEY_LOCAL_MACHINE\Software\MicroQuill\�SmartHeap\Apps\c:/apps/foo.exe

2.	At the Runtime SmartHeap or Debug SmartHeap registry key that you added in step 1, add an entry with the following values:

Value name:  PatchProcessOn

Data type:  REG_DWORD

Value:  0 (zero).  Zero means SmartHeap should not patch DLLs, and a non-zero value means that SmartHeap should patch DLLs.

To disable patching in certain DLLs in your application but not in the entire process:

Add the following key and value to the Windows NT or Windows 95 registry:

For Runtime SmartHeap, add the registry key:

HKEY_LOCAL_MACHINE\Software\MicroQuill\�SmartHeap\Apps\<app-name>\SkipDLLs

For Debug SmartHeap, add the registry key:

HKEY_LOCAL_MACHINE\Software\MicroQuill\�HeapAgent\Apps\<app-name>\SkipDLLs

Alternatively, if you’re using Debug SmartHeap with more than one application, or if you’re running your application from more than one directory, you can use the following registry key to have Debug SmartHeap skip DLLs in all applications you use with Debug SmartHeap:

HKEY_LOCAL_MACHINE\Software\MicroQuill\�HeapAgent\SkipDLLs

�At the Runtime SmartHeap or Debug SmartHeap registry key that you added in step 1, add DLLs that you do not want SmartHeap to patch.  For each DLL you want SmartHeap to skip (that is, not patch), add an entry with the following values:

Value name:  File<n> where <n> is 0 (zero) for the first DLL you add, 1 (one) for the second, and so on

Data type:  REG_SZ

Value:  the DLL name (not the full path of the DLL — just file name and extension)

To the same registry key, add another entry with the following values:

Value name:  FileCount

Data type:  REG_DWORD

Value:  the number of DLLs you’ve added to the registry key

For example, if you want to skip patching DLLs foo.dll and bar.dll, you’d add the following three registry values to the Runtime SmartHeap or Debug SmartHeap registry, as appropriate:

Name File0, type REG_SZ, value foo.dll

Name File1, type REG_SZ, value bar.dll

Name FileCount, type REG_DWORD, value 2

When you load a Debug SmartHeap application and Debug SmartHeap encounters DLLs it does not recognize and that do not have either PDB debugging information or exports of heap APIs, Debug SmartHeap will prompt you with the following message:

HeapAgent is unable to find memory allocation function symbols in module <unknown.dll>. Do you want to add <unknown.dll> to the list of DLLs HeapAgent skips in subsequent loads (choose “Yes” only if this DLL does not share the heap with your EXE or other DLLs)?

If you choose the Yes button, Debug SmartHeap adds the DLL name to the registry entry HKEY_LOCAL_MACHINE\Software\�MicroQuill\HeapAgent\SkipDLLs, so this DLL will be skipped whenever Debug SmartHeap encounters it in any application.

�To trace SmartHeap patching activity to a log file:

1.	Add the Runtime SmartHeap or Debug SmartHeap registry key as described in step 1 of “To disable SmartHeap patching for all DLLs,” above.

2.	At the registry key that you added in step 1, add an entry with the following values:

·	Value name:  PatchTraceFile

·	Data type:  REG_SZ

Value:  The full path of a file name to which SmartHeap will log all patching activity.  SmartHeap will create the file if it does not exist.



First-chance exceptions reported by your debugger

When you run your application under both SmartHeap and your source debugger at the same time, your debugger may report one or more first-chance exceptions in the Debug SmartHeap DLL, ha312w32.dll.  These exceptions are caused by SmartHeap’s address validation, which uses Win32 structured-exception handling.  The exceptions are handled by SmartHeap and are not errors in your application or in SmartHeap.

SmartHeap for Win32 calling convention

In SmartHeap versions 2.0 and 2.1 for Win32, APIs were defined with the __cdecl calling convention.  SmartHeap 2.2 and higher uses __stdcall calling convention to define its APIs, which is the calling convention used for the Windows NT and Windows 95 system DLLs.

SmartHeap Win32—specific values

The following are some platform-specific defaults and attributes for the Win32 version of SmartHeap (all values in bytes, non-debug version of SmartHeap; all values subject to change in future versions):

Description	Intel/[Alpha]	Related API, if any

Default page size	64K	MemPoolSetPageSize

Default “small” block threshold	256	MemPoolSetSmallBlockSize

Per-alloc overhead, FS blocks	0	MemAllocFS

Per-alloc overhead, “small” blocks	0	malloc, new, MemAllocPtr

Per-alloc overhead, var ptr blocks	2	malloc, new, MemAllocPtr

Granularity, block types	4/8	all

Minimum block size, FS blocks	4/8	MemAllocFS

Minimum block size, “small” blocks	4/8	malloc, new, MemAllocPtr

Minimum block size, all others	14	malloc, new, MemAllocPtr, 

Per-page overhead, all APIs	58

Minimum page size	16K	MemPoolSetPageSize

Maximum page size	64K	MemPoolSetPageSize

Size of empty memory pool	16K	MemPoolInit[FS]

�Default error handling in Windows

The default error handler in the Windows version of Runtime SmartHeap uses a task-modal message box (see MemDefaultErrorHandler in §4.2, “Function reference” in the SmartHeap Programmer’s Guide).  If there is insufficient memory to display a task-modal message box, a system modal message box is displayed.

For non-recoverable errors, the default error handler shows an OK button and a Cancel button on the message box.  For recoverable errors, Abort, Retry, and Ignore buttons are shown.

Choosing either the Cancel or Abort button causes an int 3 (breakpoint interrupt) to be executed, which will stop in the debugger if a debugger is currently running.  If no debugger is running, SmartHeap will call the abort function, which terminates the current task.

Choosing either OK or Ignore causes the SmartHeap function that reported the error to return with an error return value.  Choosing Retry causes SmartHeap to retry the operation (for example, memory allocation).

In Debug SmartHeap, an Error Report dialog box is displayed if DBGMEM_OUTPUT_PROMPT is supplied to dbgMemSetDefaultErrorOutput (it is by default).  The Debug SmartHeap Error Report dialog box contains the following buttons:

·	Debug breaks to your source debugger, or if you’re not currently running under a debugger, this button opens the current Win32 “just-in-time” debugger if you have installed one.

·	Continue resumes execution of your application.

·	Retry retries the failed operation -- this button is enabled only for out-of-memory errors.

·	Terminate closes your application.

�·	The remaining buttons on the error report dialog box are available only if you have installed SmartHeap’s sister product, HeapAgent.  HeapAgent provides a graphical user interface for controlling heap debugging settings and diagnosing heap errors.  If you have HeapAgent, these buttons are used to open HeapAgent browsers, suppress errors, or get online help about a particular error.

If DBGMEM_OUTPUT_CONSOLE is supplied to dbgMemSetDefaultErrorOutput, output is sent to the OutputDebugString Win32 API, and will be displayed in the output window of the active debugger.  DBGMEM_OUTPUT_BEEP causes a MessageBeep on errors.
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